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Notes

1 PagePlus X3

This book contains the Tabs details taken from the Serif PagePlus X3 Help
menu.

Much of the information here also applies to earlier versions of PagePlus, with
the exception of any new features that PagePlus X3 has.
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Studio Tabs

The Studio tabs comprise a set of tabs that provide easy access to a whole range of
design options, functions and features. To preserve space, tabs are docked together
into tab groups with only one tab showing in a tab group at any time. Tab groups can
be either visible or hidden; and can be placed on any side of the workspace. Hidden
tab groups slide in/out of view when you hover the mouse over tab group buttons (see
below). Tab groups are collapsible by double-clicking on their titles. Visible tabs have a
menu button at the top right, which can be used to manage the tabs.

To view sliding tab groups:

Use Tools>Options>UI Settings to make these tab groups expand/collapse
automatically (check Auto Expand on Full Bar). You can also set the tab animation to
have a Slide, Roll or Fade effect.
For most tabs, you can drag and drop items from a tab into a publication (when no
object is selected), or click a tab item to apply it to the currently selected object.

For details on customizing the arrangement of tabs, see Customizing PagePlus
toolbars, menus, and tabs.

open/close tab group
(slides to right/left)

open/close tab group
(slides upwards/downwards)

OR
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Horizontal Size
Adjust the object's width according to the current Anchor point position
(see above).
Toggle the link button to maintain your object's width/height aspect ratio
during resize, i.e.

No aspect ratio maintained. Dimensions can be adjusted
independently of each other.

Aspect ratio maintained. Horizontal and vertical sizes change in
relation to each other.

Vertical Size
Adjust the object's height according to the current anchor point position
(aspect ratio control also applies).
To maintain aspect ratio during resize, see Horizontal Size.

Horizontal Scale
Change the width of the selected object with respect to its current anchor
point, as a percentage.

Vertical Scale
Change the height of the selected object with respect to its current
anchor point, as a percentage.

Rotation Angle
Rotate the object counter-clockwise around its selected anchor point.
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Align tab
The Align tab can be used to align the edges of any two or more objects with one
another, or distribute multiple objects evenly at certain intervals. Each alignment
operation has to be carried out in turn—for a more advanced alignment option, use
Arrange>Align Objects to perform more than one operation simultaneously.

Top
Aligns to target object's top edge (multiple objects) or the top page
margin (single object).

Bottom
Aligns to target object's bottom edge (multiple objects) or the bottom
page margin (single object).

Left
Aligns to target object's left edge (multiple objects) or the left page
margin (single object).

Right
Aligns to target object's right edge (multiple objects) or the right page
margin (single object).

Centre Horizontally
Horizontally aligns to target object's centre (multiple objects) or the page
centre (single object).

Centre Vertically
Vertically aligns to target object's centre (multiple objects) or the page
centre (single object).

Spaced
Check to enable fixed amount of spacing between distributed objects; the
amount is set in the adjacent box as your currently set measurement
units. If unchecked, objects are spread evenly between the two endmost
items. Applies to Space Evenly Across and Space Evenly Down
options only.

Space Evenly Across
Spreads the selected objects horizontally—between the two endmost
items, between left/right page margins (if Include Margins is checked),
or by a fixed amount of spacing (see Spaced).

Space Evenly Down
Spreads the selected objects vertically—between the two endmost items,
between top/bottom page margins (if Include Margins is checked), or by
a fixed amount of spacing (see Spaced).

Check to align the selected object(s) with the page margins.

AlignTab
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Character tab
The Character tab combines several controls for dynamically fine-tuning text
placement and properties.

The controls are context-sensitive and are displayed according to the type of object
you've selected. You can choose from the following techniques to make adjustments:

· Click the small up- or down-arrow "spinwheel" buttons to adjust
incrementally;
OR

· Click the small right-arrow buttons, then drag the revealed slider to adjust
continuously, or click a point on the slider to select a value;
OR

· Click in the text box, then press the up or down arrows on the keyboard to
change the values shown;
OR

· Type in an exact value and press the Enter key.

Point Size
Change the text point size.

Width
Change the text width.

Spacing
Change the inter-letter spacing (tracking).

Advance
Change the position of a character, or set of characters, in
relation to their baseline. The change is measured in points and a
negative value moves the selected text upwards.

Slope
Apply an angle at which the text leans to the left or right.

Leading
Change the leading, or distance from one text baseline to the
next. The baseline is the line on which a line of text appears to sit.

Language Selector
Assigns a different language setting for the selected text or
paragraph for spell checking purposes.
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Transform tab
The Transform tab combines several controls for fine-tuning object, position, size, and
rotation. Transforms are carried out from a pre-defined anchor point which allows an
object's height, width, rotation angle and scaling (horizontal and vertical) to be adjusted
from a corner, edge midpoint or centre. An object's position can also be adjusted from
the currently set anchor point.

You can choose from the following techniques to make adjustments:
· Click the small up or down arrow "spinwheel" buttons to adjust incrementally;

OR

· Click the small right-arrow buttons, then drag the revealed slider to adjust
continuously, or click a point on the slider to select a value;
OR

· Click in the input box, then press the up or down arrows on the keyboard to
change the values shown;
OR

· Type in an exact value and press the Enter key.

Anchor Point
Select a grey square within the anchor frame so that the object's
transform will be carried out from that point on the object. For example,
an object can be resized from its top-left corner, with the blue anchor
point set accordingly, i.e.

Horizontal Position
Changes the horizontal placement according to the currently set anchor
point position (see above); measurement is in relation to the ruler's zero
point. The higher the value, the further to the right the object is moved.

Vertical Position
Changes the vertical placement according to the currently set anchor
point position (see above); measurement is in relation to the ruler's zero
point. The higher the value, the lower the object is placed on the page.

TransformTab



20 PagePlus X3

Show All
If Show All is checked, all available styles are shown in the Text
Styles tab.

Manage Styles
Accesses the Text Style Palette for the currently selected text
style by choosing this button.

Create Styles
To create your own named style (character or paragraph), select
a style on which to base your new style and click this button.
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Colour tab
The Colour tab lets you apply a colour and/or shading to a selected object's fill, line
and/or text (either as character fill or as highlighting). See topics under the Contents
heading "Colour, Fills, and Transparency" for more information about using colours.

Fill/Line/Text buttons
Click to select which object property will be affected when you
select a colour from the colour palette. The bar underneath
(shown in black) reflects the currently assigned colour.

Colour Picker
Use this tool to define the colour. After choosing the tool, click
anywhere in the workspace to "pick up" the colour under the
cursor. You can press Esc to cancel the tool. Left-click with the
tool to magnify pixels under the cursor.

Colour Mode Selector
Click the down arrow and choose from the menu to change the
current colour mode to one of the following:
· RGB (Red, Green, Blue)
· CMYK (Cyan, Magenta, Yellow, Black)
· HSL (Hue, Saturation, Lightness)
· Greyscale
· Tinting
Note: Changing the colour mode doesn't affect the image, only
the choice of available colours.

Colour Sliders
Drag a slider to "remix" the selected colour (RGB colour mode
shown) by changing one of its colour components. The
corresponding colour value box updates interactively, as does the
selected object.

Colour Spectrum
Displays the colour spectrum. Click your cursor over a desired
colour in the colour spectrum—the colour sliders and input boxes
change to show the colour at that cursor position has been
chosen. To set white, black or full transparency pick the small
boxes at the far left of the spectrum.

ColourTab
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Fonts tab (slide-in left)
The Fonts tab lets you review your currently installed fonts, preview fonts in-situ,
search for fonts and access the FontManager (if purchased). See Using fonts for
details on applying fonts to text.

Font List
Displays a list of fonts ordered alphabetically by font name (e.g.,
Accord SF), each in their own font face. The preceding symbol
indicates the type of font, i.e.

TrueType

OpenType

Type 1 (PostScript)

Raster (bitmap)

· For in-situ previews of each font, switch on Preview Font (from

tab's Tab Menu button), select a portion of Artistic or frame
text and then hover over a chosen font in the tab's font list.

· To apply a font to the selected text, click on the chosen font from
the list.

Use the tab's Tab Menu button to switch on Favourites and
Websafe categories via the Categories submenu. Recently used
fonts will show automatically as you apply fonts to your text.

Font search
Use the font search to perform a search of currently installed fonts
by name, attribute, or type.
(See the topic Using fonts).

FontManager
Click the button to access Serif FontManager. The program is a
separate product, which will be launched if installed.
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Text Styles tab
The Text Styles tab displays pre-defined character and paragraph styles that can be
assigned to frame text, table text, or artistic text. These grouped attributes make it easy
to apply complex character or paragraph styling in one step. The tab also lets you
manage styles, preview text styles in-situ (and bulk assign new styles) and update a
listed style to match the style of the current text selection.

Style name
Paragraph or character styles are listed in the Text Styles tab.
Paragraph styles (shown with a   symbol) are ordered
alphabetically but separately from character styles (shown with a
     symbol).

· To apply a paragraph style, click on any type of text to create an
insertion point then select a paragraph style from the list.

· To apply a character style (if defined), select a portion of text
then pick a character style from the list.

· To make a style adopt the attributes of currently selected text,
right-click on the style to be updated and choose Update <style>
to Match Selection.

· To select all text using the same style, right-click on the style and
choose "Select All n Instances" (where n is the number of
matches).

· To modify or delete a text style, right-click on the style and
choose Modify <style> or Delete <style>.
For details, see the topic Using text styles.

· To remove local character and paragraph formatting and revert
to the default paragraph font, select text and click Clear
Formatting (clears both simultaneously), or choose Apply to
Paragraph, Apply to Character or Apply to Both from the drop-
down menu.

· To remove local character and paragraph style overrides, select
one or more paragraphs and click Reapply Formatting (clears
both simultaneously), or choose Apply to Paragraph, Apply to
Character or Apply to Both from the drop-down menu.

Preview Styles
If Preview Styles is checked, the style's formatting is reflected in
the tab's displayed style names.

Text StylesTab
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Scheme Colours
The numbered samples in the gallery represent the basic colours (1-
5) selected from the Schemes tab. As with paint-by-numbers, when
you assign a colour number to an object, the object takes on the
corresponding colour in the current scheme. For example, if the third
colour in the current scheme is green, objects marked with "Scheme
Colour 3" will appear green.

The right-most button allows access to the Scheme Manager for the
editing of existing colour schemes, as well as creation of new
schemes.

Tint
Click on the arrow to vary the colour shade/tint of a selected object
with a slider. Dragging left (-) for Shades progressively adds black to
the colour for a darkening effect, while dragging right (+) for Tints
progressively adds white for a lightening effect. You can also select a
percentage value in the input box.
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Gallery tab
The Gallery tab serves as a container for storing any design objects you'd like to reuse
in different publications. It also includes sample designs and (when you install the
PagePlus X3 Resource DVD) is stocked with a wide variety of pre-designed elements
that you can customize and use as a starting point for your own designs. Once you've
copied a design to your Gallery tab, the design is available in any publication! For
details, see Using the Gallery.

The Gallery has two parts: (1) an upper Categories group and (2)
a lower set of Designs. To choose a Gallery category, navigate
around the Categories tree menu and click a category name in
the list.

Designs
Displays the gallery of items for the selected category.

· To use a Gallery object, drag it onto the page.
· To add an object to the current category, drag it into the gallery.
(To copy an item, hold down the Ctrl key while dragging.)
· Select the drop-down icon on any design thumbnail you create
to access functions for renaming or deleting designs, etc.

How To tab (docked left)
   The How To tab provides step-by-step information
   to help you perform the most common publishing
   tasks.

Gallery / How ToTab
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Layers tab
The Layers tab includes controls for creating, deleting, arranging, merging, previewing
and setting the properties of layers within your publication. See Working with layers for
more information.

Layer name
Typically, each publication, when created from scratch, has a single
layer.
· To select and work on a layer, ensure      the layer arrow is shown on
the layer (click at the very start of the layer's row to set the arrow on the
layer). The ordering of layer names reflects how layers are stacked in the
image. Right-click layer names for more options.

Master Page(s)
Double-click under this column for the layer in question to assign/modify
a master page to the layer. A Select Master Page dialog is displayed.
The layer entry will show the assigned master page (e.g. "A") when
assigned.

Visible
Check the box in the Visible column to show the layer and any objects
on it; uncheck to hide the layer.

Master Page(s) Visible
Check the box in the column to show the layer's master page; uncheck to
hide it.

Printable
Check the Printable column to include the layer in page printouts;
uncheck to exclude it.

Locked
Check the box in the Locked column to prevent objects on the layer from
being selected/edited; uncheck to allow editing.

Layer options
Double-click the button to display the Layer Options dialog. This sets the
above Visible, Printable and Locked options for the currently selected
layer. The selection handle colour can also be set by clicking on the
Selection handle button; choose a colour from the palette (click More
Colours... for a wider choice).

To extend Layer Options dialog settings to layers with the same name
throughout the publication, check Apply to all layers with the same
name.

Insert new layer
Adds a new layer above the currently selected layer.
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Swatches tab
The Swatches tab can be used to apply preset solid colours, gradient fills, bitmap fills
and shading to your publication from a series of galleries.
Presets are laid out as resizable swatches which can be added to with your own choice
of solid colours or fills (see topics under the Contents heading "Colour, Fills, and
Transparency" for more information about using colours).
Click any gallery sample to apply that colour as a solid fill to the object, either by
selecting the object or by drag and drop onto it.
The current document's colour scheme is also at hand to allow easy assignment of
scheme colours, obtained from the Scheme Manager.

Fill/Line/Text buttons
Click to select which object property will be affected when you select
a colour from the tabs' palettes. The colour of the underline reflects
the colour of your selected object.

Publication Palette
Stores commonly used and previously applied solid colours or fills to
allow easy reuse in your document. Colours are added automatically
to this gallery as they are applied to your publication.

Palette
Provides preset gallery colours from a choice of standard palettes,
including Standard RGB and Standard CMYK. The first cell shows ,

       which represents either None (a transparent interior for objects
with line/fill properties) or Original (for pictures only, to reset the
object to its original colours).
The drop-down menu allows differently themed Palettes (e.g., Warm,
Earth, Fruit) to be used.

Gradient
Provides preset gallery gradient fills. The drop-down menu provides a
choice of galleries—for Linear, Elliptical, or Conical fills.

Bitmap
Provides preset gallery bitmap fills. The drop-down menu provides an
extensive range of categorized themes such as Water, Metal,
Patterns, etc.

SwatchesTab
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Schemes tab
The Schemes tab displays a list of available colour schemes (see the topic Using
colour schemes).

Any colour scheme can be applied to the current layout by clicking on
the scheme name. The publication's current colour scheme is
highlighted.

To add, modify, or delete a colour scheme, select the Tab Menu
button with the Schemes tab is selected. Choose Scheme
Manager... from the flyout menu (alternatively, choose Scheme
Manager... from the Tools menu).

Styles tab
The Styles tab provides multiple galleries of pre-designed styles that you can apply to
any object, or customize to suit your own taste. Each object style can include settings
for multiple object attributes such as line colour, line style, fill, transparency, filter
effects, font, and border. (Click the links for details on any property. For an overview,
see the topic Using object styles.)

Style Categories
Select a category from the drop-down list.

Once a category is selected, click "+" and "-" to expand or collapse
subcategories if needed; subcategories are expanded by default.

To add, remove, or reorder categories and subcategories, select the

tab's Tab Menu button and choose Object Style Manager... from
the flyout menu. Style thumbnails within categories can also be
reordered.

Styles
Displays pre-designed styles for the selected subcategory, e.g. Mixed
styles.
· To apply a style to one or more objects, click a style thumbnail to
apply it to the selected object(s).
· To edit, copy, or delete an object style, right-click its thumbnail.
Editing an object loads the Style Attributes Editor where specific style
attributes can be saved as a new object style.

Schemes
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Delete selected layer(s)
Deletes one or more selected layers.

Move layer up
Moves the currently selected layer one layer up in the stack (TIP: you
can also move the layer by dragging its name).

Move layer down
Moves the currently selected layer one layer down in the stack (TIP: you
can also move the layer by dragging its name).

Merge into active layer
To merge a layer, select the layer you want to merge to by clicking its
entry, press the Ctrl key then select the layer(s) you want to merge, and
click this button. The contents of the merged layer appear on the active
layer.

Preview selected layer
Shows a preview of the currently selected layer in a dialog.

Layer options
Displays the layer options dialog as described above.

Edit all layers
Enable this button if you want to be able to select and edit object on all
layers. Otherwise only objects on the currently selected layer can be
edited.

LayersTab
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Line tab
The Line tab lets you set the weight, type, and start/end termination of lines and shape
outlines, as well as the Cap (end) and the Join (corner) where two lines intersect (see
the topic Setting line properties).

Weight
Drag (or enter a point value and press Enter) to change the
weight (thickness) of the selected line.

Start Style
Displays the style of the start point of the selected line. To change
the style, click a different example in the drop-down list.

Type
Displays the type of the selected line (solid, calligraphic, dotted,
dashed, double). To change the type, click a different example in
the drop-down list. Use the controls just below to create a custom
line:
· For Dashed lines, click and drag the Dash Pattern slider to set
the overall pattern length (the number of boxes to the left of the
slider) and the dash length (the number of those boxes that are
black).
· For Calligraphic lines of variable width (drawn as if with a
square-tipped pen held at a certain angle), select the calligraphic
line from the drop-down menu then use the displayed
Calligraphic Angle control to set the angle of the pen tip.

End
Displays the style of the end point of the selected line. To change
the style, click a different example in the drop-down list.

Select a Cap setting (Round, Extended or Flat) to vary the
contour of the line end.

Select a Join setting (Bevelled, Direct, or Rounded) to
determine the contour of the corner where two lines intersect.
A Direct corner can be either sharp or flat (beveled),
depending on the Limit setting. This indicates how far
(number of line widths) PagePlus should extend each line at
the junction. If the two outer edges meet within that limit, the
result is a sharp corner; if not, you'll get a flat (Bevel) corner.

Check Behind to hide the inner half of the line behind a
closed shape; if unchecked, the whole line appears in front
(the wider the line, the more it encroaches on the filled region).
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Pages tab
The Pages tab displays thumbnail representations of normal and master pages in the
publication (see the topic Adding, removing, and rearranging pages).

Master Page button
Click to expand or collapse a window showing master page(s) in the
current publication.

Page Manager
Click to launch the Page Manager for advanced control of
pages/master pages.

Add
Click to add a page (or master page) before the currently selected
thumbnail in the window.

Remove
Click to delete the page (or master page) whose thumbnail is
currently selected in the window.

Show page names
Displays the master page name used on the currently selected
page(s). The master page is represented as a letter superimposed on
the Page, e.g. A, B, C, etc.

Page Thumbnail
Each page or master page is depicted with a thumbnail.
· To select a page or master page for insertion or deletion, click its
thumbnail.
· To work on a page or master page, double-click its thumbnail.
· To rearrange pages, drag a page thumbnail to a new place in the
page sequence.

The Tab Menu button displays a drop-down menu from which the Page Manager or
Master Page Manager can be selected. This provides multiple options for inserting and
deleting pages or master pages, assigning master pages to pages, and navigating to a
page.

PagesTab
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Navigator tab
The Navigator tab lets you quickly zoom into and pan around magnified areas of your
publication. The tab is collapsed in the default workspace.

View Box
Shows the portion of the page currently displayed in the workspace.
Drag the red view box to pan around your page nad use the corner
handles to set the zoomed in area.

Zoom In/ Zoom Out
Use the controls to zoom in or zoom out of your page.

Transparency tab
The Transparency tab lets you apply a transparency effect to an object. You can apply
Solid, Gradient, or Bitmap transparency to images, shapes, text frames, tables, and
characters inside an artistic text object. For details, see the topic Working with
transparency.

Solid
Click to choose from a selection of solid transparency options
displayed in the supporting Solid transparency gallery.

Gradient
Click to choose from a selection of gradient filled transparency
options in the Gradient transparency gallery.

Bitmap
Click to display a gallery of available bitmap-based transparency
options. You can also click on the drop-down arrow to swap between
different transparent bitmap categories.

Transparency gallery
Displays samples of available transparencies.
· Select one or more object(s) and click a gallery sample for the
transparency you want to apply.
OR
· Drag from the gallery sample onto any object (the cursor changes
over suitable objects), and release the mouse button.

Navigator
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Check Scale if you want both a closed shape and its outline to
change size in proportion if you resize the object; otherwise,
line weight will remain constant if the object is resized.

Dash Pattern
Change white squares to black (by clicking) to build up a pattern
which will be replicated along your dotted line. First drag the arrow
to the right to set the length of the repeating pattern.

LineTab
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Media Bar (docked bottom)
The Media Bar lets you create on-screen collections of photos for drag and drop
directly onto your page, and to replace standalone pictures and those in picture frames.
You can add images and folders to temporary or saved albums, search for file names
and photo tags and sort your photos.

Sort By
Arrange photos in the Media Bar by clicking the down arrow and
choosing File name, Rating or Date taken.

Add Image...
Click to add images to the currently displayed album.

Add Folder...
Click to add images from an entire folder to the currently displayed
album.

Remove Image
Removes the currently selected photo.

File name/tag search
Enter a file name (full or partial) or tag string to retrieve matching
photos in the lower photo window.

· Use the       down arrow to search for specifically rated photos (1 to
5 stars).
See the sub-topic Searching for photos in albums.

Album Select
Click the down arrow to select a saved album, Temporary Album,
All Albums or create a new album (New Album...).

! You can't add files or folders (or delete files) when All Albums is
selected.

The Media Bar's window hosts photos in your currently selected
album (temporary or saved) or all albums.

· Right-click on the background to Add Images... or Remove All
Images.

· Right-click on any thumbnail to do the above, plus add XMP tags or
view all tags (Manage Tags...), Remove Image, or display the
photo's folder in Windows Explorer (Locate in Explorer).

New Album
Click to create a new empty album.
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AutoFlow
Click to automatically populate empty picture frames in your
publication with your currently displayed albums' photos.

Add To
Click to add your temporary albums' photos into a New Album or a
previously saved album (choose from menu flyout).

Manage
Click to display the currently loaded album's settings including each
photo's Path, Filename, DPI (96 DPI or Native) and link status
(Embed/Link).

You can also add photos or folders from the dialog.

Media BarTab


